
SUPERPRO® 7100 User's Guide                                 - 1 -      

User's Guide  

 

 
 

XELTEK  

SuperPro® 7100  

Series  

 

 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 

XELTEK  

1296 Kifer Rd. Unit 605  
Sunnyvale, CA 94086  
Tel: (408) 530‐8080 Fax: (408) 

530‐0096  
www.xeltek.com  

http://www.xeltek.com/


SUPERPRO® 7100 User's Guide                                 - 2 -      

IMPORTANT!  

1. This manual applies to SuperPro 7100.  

2. Make sure the software installation is completed before connecting the 

programmer to PC.  

3. Please read the manual carefully before using programmers.  

4. Please use Xeltek Adapters. Non‐Xeltek adapters will cause errors.  
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Fax: (408) 530‐0096  
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SUPERPRO is the registered trademark of XELTEK.  
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COPYRIGHT 

 

Software Copyright  2012‐2020 XELTEK  

User’s Guide Copyright   2012‐2020 XELTEK  

 

SUPERPRO for Windows software and this manual is copyrighted by Xeltek, Inc.  

 

Distribution and sales of this product are intended for use by the original purchaser under the terms of the 

License Agreement.  

 
This document may not, in whole or part, be copied, photocopied, reproduced, translated or reduced to 

any electronic medium of machine‐readable form without prior consent in writing from XELTEK.  

 
The information in this document is subject to change without notice.  

 

 

Not correspondence with this manual due to software 

updating, the software will be the final.    
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Chapter 1 Overview  

This section provides a brief introduction of SUPERPRO (1.1), software features (1.2), structure of the 

handbook (1.3), system requirement for the installation (1.4), and package content (1.5).  

1.1 Introduction to SUPERPRO 

The SUPERPRO is menu-driven software that operates a series of cost-effective, reliable, and high-speed 

universal programmers. SUPERPRO communicates through a USB 2.0 port and operates with most IBM-

compatible desktop and notebook computers that based on Pentium. Menu-driven software interface 

makes all the operations quite user-friendly.  

1.2 Software feature (USB2.0 Series) 

The USB 2.0 Series supports:  

• Windows XP, Windows Vista, and Windows 7  

• Large amount of types of devices, including E/EPROM, PLD, MCU, FLASH, etc.  

• Compatible with many types of file formats, such as Binary, Intel (linear & segmented) Hex, 

Motorola S, Tektronix (linear & segmented), Jed, pof, etc.  

• It supports a plug-in test (48 pins or less) to detect defective chips, improper insertion and pins 

that are poorly contacted.  

• SUPERPRO has an integral full-screen buffer editorial environment with commands such as fill, 

copy, move, swap, etc.  

• Electronic serial numbers are generated automatically.  

1.3 Structure of this User's Guide  

The content of this User's Guide is structured into three major sections. 

Section 1 is an overview and introduction of the SUPERPRO, describing the system requirement, 

installation of the hardware and software.  

Section 2 is about detailed specification and explanation of all the features, commands, and 

function modules.  

Section3, Appendices, has supportive information and guide for trouble-shooting.   

1.4 System requirements  

The minimum system configuration requires:  
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• A desktop or laptop computer with Intel Pentium or an equivalent processor and at least one 

serial USB 2.0 Bus interface.  

• Windows XP, Windows Vista, and/or Windows 7 operating system  

• 1 GB free space on the hard drive, determined by the size to be written. For example, if the 

content to be written is 4G, the minimum space available must be larger than 4G; otherwise the 

operation cannot be finished.  

• A CD drive  

1.5 Package content  

A standard SUPERPRO programmer package includes:  

• A Programming host machine  

• A USB 2.0 connection cable  

• A Power supply unit  

• One CD (contain programmer software and User’s Guide)  

• User registration table 

 

 

  

  



SUPERPRO® 7100 User's Guide                                 - 10 -      

Chapter 2 Software Installation 

If you are the first time to use Xeltek universal programmer based on USB, this chapter provides a brief 

guidance on how to install the SUPERPRO software and connect the programmer hardware properly. 

USB device is plug-and-play, so when the first time to install, Windows will scan all available INF files 

through the "Add New Hardware Wizard" of Windows system. To avoid USB device installation trouble, 

we strongly recommend you to install programmer software first, the INF files and driver for USB device 

installation will be processed automatically. 

 

2.1 Software setup from CD  

Insert the CD into the CD-ROM drive.  

If the setup program starts automatically, a dialogue will come out for you to choose a programmer 

model; if the setup program does not start automatically, run SETUP.EXE located in the root 

directory.  

According to your purchased programmer, choose the right model, and click the button “Setup” to 

install programmer software.  
 

NOTE: Each model has its own software and they are NOT compatible. 
 

2.2 Download the software from website and setup 

(recommended)  

You can also download the specific software for a certain model at Xeltek website: 

http://www.xeltek.com. Select the icon to download the appropriate file for your programmer. 

Once you have saved the file to your computer, and run it to setup the software.  

 

2.3 Software Setup Procedures (Example by SUPERPRO/7100) 

The software installation will be done step by step, and users can change default settings during the 

setup procedures.  

1. Once the setup program is running, a dialog box displays to allow the user choosing a preferred 

language.  
 
 
 

http://www.xeltek.com/
http://www.xeltek.com/
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Select one from the drop down list and click OK to continue.  

 

 

 

 

 

 

 

 

 

 

 

After this dialogue finishes, another dialogue will come out automatically.  

2. An installation wizard will be displayed (as illustrated below).  
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3. A License Agreement will be displayed. Click I Agree to continue.  
 

 
Read this agreement carefully. Agreeing to install means accept the agreement by 
default. Click I Agree to continue or click Cancel to quit. 

 

4. Choose the Destination Location in which the driver software will be installed. Click Browse to 

change the default destination location. Once the destination file folder is selected, click Next to 

proceed.  

 

5. Another dialog box will be presented and allow the user to choose whether creating a start menu 

icon and/or a desktop icon. Once correctly check the box(es), click Next to continue.  

 

6. Check the previous selections and click Install to start the installation.  
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Copy, driver setup and software registration will be done here.  

 

NOTE: If you are using the Windows Vista system, the operation system may display the 

following dialog box to ask you whether to install the software. Select Install this driver 

software anyway.  
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7. Once the installation is completed, click Finish.  

 
 

2.4 Hardware and Driver Installation  

Connect a programmer and a computer by USB (Universal Serial Bus), and then turn on the 

programmer power.  

 

After you set up the software, you can install the hardware and driver automatically. When 

you connect the new hardware, the system initiates the New Hardware Wizard, which 

locates the driver from the software you have just installed. The system displays one alert 

message at a time, illustrated below. The alert message on your system may be slightly 

different.  
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2.5 Programmer Software 

Programmer software has a standard Windows interface, including drop-down menu, buttons, 

etc. Users should be familiar with Windows operation system, and can skillfully use mouser. 

 

Programmer software will communicate with programmer hardware and initiate it immediately 

after its start. If failing, please check as the following steps: 

 Connect programmer and computer properly, and turn on power 

 Setup procedure properly. If connecting programmer hardware before installing software, 

computer will detect new hardware, and following window will show up: 

To avoid compatible ID setup software is used to make troubles, please click Cancel immediately.  

Chapter 3 Quick Guidance to Write Devices  

This chapter is a quick guidance to write devices, including: 

 Software user interface 

 Procedure to write devices 

 Programmer hardware interface 

Before you are ready to write devices, please make sure that the programmer driver has been set up, 

and the programmer has been connected by USB. The SUPERPRO/7100 is a multi-purpose, ultra-high-

speed, multi-channel, universal programmer, and suitable for R&D and production. It has two working 

modes: 

• Online mode: Connected to PC USB by USB2.0 cable, the programmer has an extremely user-

friendly and powerful interface. Also the programmer can be connected to PC by a standard 

network cable, and it works under network mode. We recommend USB mode, and online mode 

refers to USB mode.  

• Stand-alone mode: Operated by a keyboard and LCD screen, not necessary connected to PC. 

Save user engineering document on SD card. Users can make engineering document under online 

mode and download it on SD card, or copy it to SD card. Note: Stand-alone mode does not support 

the function of generating serial number automatically.  

Additionally, it supplies API interface and command line mode, and integrate programmer system into 

customers’ systems to form a completely automatic writing system which is popular in ICT testing or 

automatic production lines.  

This Chapter will introduce Online Mode, and Stand-alone Mode will be discussed in later chapters. 
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3.1 The User's Interface  

Running the programmer software, the following user interface will come out:  

 

   

1. Menu Bar               2. Tool Bar           3. Command Window   

4. Programmer Statue Panel  5. Device Status Panel  6. Buffer Panel   

7. Data File Panel           8. The Log Window  

 
 

A detailed specification of the Programmer Status Panel is shown in the picture below: 
 

 

1. Module number and the programmer ID 
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2. Auto/Cancel button  

3. Device name and the manufacturer information  

4. Status bar  

5. Statistic information panel  

6. Count down settings and information  

7. Programmer status panel  

8. Serial number  

3.2 Programming Procedures  

Before using the programmer to write a device, make sure that the programmer is installed properly 

and that the computer and programmer communicate successfully. Insert USB cable and turn on 

power as shown in the following picture.  

 

 

3.2.1 Select the device  

To open the Device Selection window, click Select the Device icon or select the Device menu and 

select the Select Device option. First choose adapter mode (including ordinary, GANG2, GANG4, and 

ISP), and then choose Device Type, for example, E/EPROM, BPROM, SRAM, PLD OR MCU. Next, 

select manufacturer and device name, and click OK. Also by searching device name in editing 

windows to narrow searching, choose devices quickly.  
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NOTE: The red device name means that such device(s) need authorization for use.  

3.2.2 Load data into buffer 

The process of programming chips is to load buffer data into chip memory units per manufacturers’ 

requirements. There are two ways to load data into buffer: 

 

1. Read data from a file 

Select Load File from the File menu to load data from a file into buffer. Input the relative file 

folder and name into the Load File dialog box, and then choose file format from the File Type 

dialogue box. Next load file data into buffer after confirmation. To make sure the loaded data 

correct, one can review the information in the Buffer window.  

 

NOTE: Some Hex or S record files contain non-zero file initial address. In this case, enter the start 

address in the File Address box.  

 

2. Read the data from a master chip 

Insert the master chip in the socket after device selection, and select Read on the Device Operation 

window in the main screen. The data will be copied from the master chip to the buffer memory. To 

make sure the loaded data correct, one can review the information in the Buffer window. You can save 

the data to a disk for later use.  

 

NOTE: The read function is not available for some devices, including those encrypted.  

3.2.3 Set options 

1) Operation Option  
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 Insertion Test Choice: To determine whether to check insertion before writing chips. 

 Serial Number Auto Increment Function: If choosing to write the accumulative number at the 

specified position when programming, all the written chips will have different numbers.  

 Change Device: Need the start and end address of the to-be-written area. 

 Verify Mode: By data manual's requirement, choose specified VCC verification voltage to verify the 
programming's rightness. 

 If the chosen device algorithm can program multiple chips simultaneously, choose the unit to be 

written first. By default, all units ( channels) are chosen, so customers can choose which units to 

be written at their will. 

2) Auto 

In the Device Operation Window, each device has a basic batch operation Auto. It will run other 

operation functions in fixed order automatically. Ordinary devices choose the following automatic 

programming mode.  

 Erase 

 Blank_check 

 Program 

 Verify 

 Security or Protect 

3) Device Configuration Word 

For devices that include the configuration word, you must set the configuration word before 
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programming to ensure that the chip can be used on the target system. The configuration words for 

some devices are contained in the user data file, and can be written into configuration word buffer 

automatically when loading data file. For some devices, you must manually make the selection.  

4) Device Menu 

After selecting devices, the device menu dialogue box will come out to display device status. Many 

devices must meet some special requirements for the programming of a chip, including special 

algorithms conventions. Read the device manual or instructions carefully and adjust the operation steps 

or buffer data as needed. Simultaneously, connect programming cable and chip pins by pin connection 

guidance, which is an important step in online mode.  

5) Production Mode 

Online programmer cannot do pin detecting, therefore production mode is different from ordinary 

programmers. The system control port of a programmer supplies an input detecting pin. In production 

mode, once high-voltage detected, AUTO operation will be initiated automatically (Details are shown in 

3.4 Programmer Hardware Interface). 

3.2.4 Execute programming, loading buffer data into the chips  

Users can buy adapters by the given instruction, and insert chips properly. 

The procedure to program chips is as following: 

 Blank_Check. If the chip is new, ignore this step. 

 Program 

 Verify. Verification is a must. Only after the verification succeeds, the chip programming is 

confirmed right. Some chips do not supply unit to unit verification function but accumulative 

verification function similar to Verify CRC. Very few chips even do not supply accumulative 

verification functions.  

 As to erasable chips with data, blank-check will fail. At this time, Erase operation should be 

executed first. Some EEPROM devices can be programmed directly without erasing first.  

 If the device needs encryption, add Security or Protect function after verification. Note: The 

encryption for some devices needs to set device configuration word first. Please refer to 

Function Details.  

 

  Users can choose Auto to finish all functions at one time.  
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3.2.5 Safety and Password 

    To protect user's data from being used by others, input passwords during the process. 

 Set password: Input new password 

 

                  1．New password            2. Password confirmation 

When text in box 1 is same with text in box 2, the password is valid. When the texts in box 1 and 2 are 

empty, it means password unnecessary. 

Note: Space can also be used as password.  

 Password Confirmation: Need when operating the protected data.  

 

The description mentioned above is a must process to write a chip. If you are first time to use, please 

read chapters about Function Details for details.  
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3.3 Project File 

Project file is a special file type for programmer(.prj). It contains all information for programming, such 

as customer settings, options, Auto and data to be programmed. Project is required for stand-alone 

mode. 

 

The standard procedures to create a project file: 

Select device -> Load data -> Option setting -> Auto edit -> Configure word setting -> Save project 

 

Every step is described in detail in section 3.2. NOTE: No need to set configure word If device has no 

“Configure word”. 

 

If user will program a large amount IC, it’s better to create a project file first. Load the project file 

before start to program after running S/W and it’s no need to repeat the steps of various settings. This 

is convenient ,and avoids man-made mistakes. 

 

3.4 Programmer Channel Introduction 

SP7100 supports 4 channels or 2 channels, and their layout are shown below.  

 

4 Channels 

 

2 Channels 

For example, if Nor Flash chips have many pins, just two channels can be supported, that is, AB 

channel or CD channel. AB channel is Channel 1, and CD channel is Channel 2.  
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3.5 Programming When Connected by Hub  

SUPERPRO/7100 provides a connection hub and user can simultaneously operate multiple 

SUPERPRO/7100 programmers by using the hub. Click menu Programmer－> Module Management, 

and select the number of the programmer you want to operate. Picture below shows the interface 

when simultaneously operating three programmers. Every programmer has a unique number such as 

“01”,”02”….., and the programmer's first line of the LCD display will show the number of this 

programmer. The numbers displayed on the screen are correspondence with the ones on the software 

interface. The module that is selected at the time will be highlighted. The device that is going to be 

programmed can be different type(s) in each of the module that is connected through the hub.  

 

In normal mode, all operations (i.e. selecting devices, loading documents and programming) are carried 

out in the programmer that is selected and highlighted at the time being. In global configuration mode, 

all the operations (i.e. selecting devices, loading documents and programming) are carried out in the 

programmer(s) that is selected with the check in tick-box(es) (excluding the operation buttons on the 

programmer board).   
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Statistics Column: 

 

  

NOTE:  

1. Choose specified hub for XELTEK to connect SUPERPRO/7100, and currently up to 8 programmers 

can be operated simultaneously.  

2. The visible panel number can be adjusted by the programmer panel style.  
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Chapter 4 Functions and Commands 

This chapter provides a detailed specification and explanation of the SUPERPRO®  

software. It includes the description of the functions and commands that is listed as  

below,  

• File Menu and Tool Bar  

• Edit Buffer and File information Frame  

• Device Operation Function Menu  

• Operation Information Menu  

• Status Bar  

• Statistics Window  

4.1 File Menu and Tool Bar  

4.1.1 File and Data 

There may be one or more data buffers in the device. If several data buffers are displayed after you 

have selected the device, refer to the name and the data manual for the meanings of the buffers.  

 

The two data types of the device are Data (HEX/ASCII) and Fuse.  

• For most EPROM and SCM, the data type is Data (HEX/ASCII).  

• The data type for PLD device is Fuse.  

 

After you select the device, the software will automatically identify the data buffer type. You can review 

the buffer data types if you open the Edit dialog box for the data buffer.  
  

4.1.1.1 Load File 

When some file data are loaded into the data buffer, the following rules apply:  

•  With a HEX/ASCII data buffer (EPROM, MCU etc.), the system assumes that 8 bits of the data are 

valid.  

•  With a JEDEC buffer (PLD/PAL), the system considers the lowest bit (1 bit) of the file data valid.  
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Select Load from the File menu to open the Load File dialog box, as illustrated below.  
 

 

1. Buffer. Select the Buffer name from the drop down list. The system loads the file data into the buffer 

accordingly.  

2. File Name. Enter the name of the data file to load, or you can select Browse and choose the file using 

the Select File box (see figure below).  

 

 

When the data type is HEX/ASCII, divide the file into many types according to the saved files. So 
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after selecting files, to ensure loading data properly, it is necessary to choose the file types. 

 

3. File Type.  Different file types are included here, e.g. Binary, Intel Hex, Motorola S record, JEDEC, 

POF, TI, etc.  

4. File Mode.   

Select one of the following File Modes from the drop down list:  

• Normal: Load the whole file  

• Even: Select the first byte and discard the second byte out of every two bytes  

• Odd: Discard the first byte and load the second byte out of every two bytes  

• 1st byte of 4: Load first byte and discard the other three bytes out of every four bytes  

• 2nd byte of 4: Load the second byte and discard the other three bytes out of every four bytes  

• 3rd byte of 4: Load the third byte and discard the other three bytes out of every four bytes  

• 4th byte of 4: Load the fourth byte and discard the other three bytes out of every four bytes  

• 1st 2_byte of 4: Load the first two bytes and discard the other two bytes out of every four bytes  

•2nd 2_byte of 4: Load the last two bytes and discard the other two bytes out of every four bytes  

5. Buffer offset Address. Start from the initial address when loading data into buffer.  

6. File offset Address. In case the file type has a non-zero start address, enter the data offset address in 

the File Address field. Make sure to enter the correct address, because an incorrect file offset address 

causes part of the buffer to be filled with FF (or incorrect data).  

7. Buffer clears on data load. Tick this checkbox will enable the user to fill the data buffers with the 

specified data.  
 

NOTE: When the device supports special files to load (e.g. ELF), the User Defined multiple-

choice box window will come out. If check, loading file as the special loading mode, and disable 

most loading option.  
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4.1.1.2 Save File 

Select Save from the File menu to save data in the current buffer to a disk file. A dialog box titled as 

Save File will be displayed and the saving options are similar to those in section 4.1.1 Load File.  

 

1. Buffer.  

2. File Name  

3. File Type  

4. Buffer Address  
5. Data Size. To enter the save data size in number of bytes. 

4.1.2 Project Menu  

The project is a file to save all the current engineering environment, containing: 

• The current device's information, such as:  

o Manufacturer  

o Device type  

o Pin information, 

o Size  

o Data file name  

o Current buffer data  

NOTE: The buffer data may be revised after loaded, and the revised date will be the final. So 

the buffer data may differ from the data files.  
 

• All Operation Option settings  

• The content of the Auto mode  
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• Software module related to the project (For more information, please refer to the “Protection 

Mode”) 

 

Generally speaking, the project file saves all the preparation related to programming. Users can restore 

the engineering environment any time. Note: The project file is related to the programmer software. If 

the software has upgraded or has been re-installed to another folder, the saved project files become 

ineffective.  
 

4.1.2.1 Load Project File 

Select Load Project from the Project menu to load a project file. Change the device(s), data in buffer, 

and operation option accordingly by the information that is provided by the project file. 
 

 

Once the Project File was set as "Dynamic Password", a series of random numbers will come 
out, and the user needs to supply the random numbers to the project file manufacturer. The 
project file manufacturer gets a dynamic number from " Password Generator"(For more 
information, refer to "Password Generator ") , and tells the user the password. The user can 
load project by inputting the password in the password box. 

4.1.2.2 Save Project Files  

Save the current working environment into a specified project file. To ensure the security of the data, 

you can encrypt the project file. NOTE: The project file name can be made of max 15 characters, and 

only be saved using the .prj extension. If the size of project file is larger than 4G bytes, the project file 

will be cut into several parts, and the suffix is xxx.prj.part, xxx.prj.part0 …  When used stand-alone, 

all these files are saved on SD card. 
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Once check the box Enter protected mode after loading the project, a box of Protection mode setting 

will come out. For more detailed information, please refer to Protection Mode Setting.   

 
                                   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dynamic Password: If the setting includes dynamic password, please save the password carefully. 

(Please refer to Load Project File and Password Generator.)  

4.1.2.3 Manage Project Library  

The stand-alone operation is when the programmer hardware is not connected to a computer, and 

uses information saved in its own module for volume production. The stand-alone file includes all the 

information needed for programming the device. This enables the user to prepare the project file(s) 

before starting the programmer's operation. The project file being saved in the stand-alone mode will 
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be manageable using Manage Project Library function. This type of file can be stored in the SD card . 

NOTE:  

1) Besides using Manage Project Library function, user can also copy the project file(s) by SD card 

replication;  

2) SD card is the memory for SPIS7100. So please ensure that SD card's file system must be FAT32.  

The figure below shows a typical Manage Project Library window.  

 

 means the project is broken. 

 

The project library size has something to do with SD card. So please ensure the 

programmer hardware is connected with a computer and the programmer has 

SD cards before operating.  

 

Some basic commands related to the project file operation are:  

• Send Project. This will send the existing project file(s) to the SD card. One can also encrypt the 

SD card to protect the data.  

• Delete Project. Delete the selected project in the SD card.  

 

There are many SD card manufacturers in the market and the quality varies a lot across different brands. 

The ones from KingstonTM, and SandiskTM are recommended. The operation speed at High Speed 

Mode is much higher than at Low Speed Mode. Additionally, users can copy project files to SD card 

directly by SD card reader. If there are many large project files need to be sent, such as larger than 

hundreds M bytes, we recommend to copy the project file to SD with SD card reader directly. 

4.1.2.4 SD card Operation 

SPIS7100 enables the encryption of SD card. Some SD card encryption operations are,  
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• Set password. Set a 6-character password for a SD card. Once a SD card is protected by a 

password, it becomes encrypted and needs the password for any operation.   

• Unlock. To enter the correct password enables operation on the SD card when it is connected 

on-line. However, if the SD card is off-line/disconnected, the user has to unlock it again for any 

other operation.  

• Erase Password. This operation actually wipes all the information that is stored in the SD card 

and removes the password. After this, the SD card needs to be formatted as FAT32 for being used 

on SPIS7100 again.  

 

Customers can run Erase Password command directly without running Unlock first if they want to erase 

SD password. Additionally, some former SD cards maybe experience operation failure. By these 

functions and volume setting, customers can strictly control the production volume in stand-alone 

mode.  

4.1.3 Device Menu 

Before any operation, users must inform the programmer which device to be written so that it can 

choose an algorithm according to the manufacturer and device name.  

4.1.3.1 Device selection  

Select Device dialogue includes Manufacturer, Device Name, Type, Ok button, Cancel button and Search 

control item. How to select a device? 
 Select an adapter from Adapter Mode. Normal, GANG-2, GANG-4 or ISP, if uncertain, please select 

All. Users can confirm the adapter mode for the current chips by the right bottom icons.  
  Select type from Type button. There are five types of devices, E/EPROM (EPROM,EEPROM,FLASH, 

etc) ,PLD,B/PROM,DRAM/SRAM,MCU. If uncertain, please select All. 
 Select a manufacturer from Manufacturer box.  
 Select a device name from Device Name box, and then press OK button.  

Maybe the printed name on the chips is different from the name in the Select Device box due to 
other parameters such as speed, temperature, package, etc. Please ignore these parameters or ask 
for help.  

How to use Search Box: Due to large amount of devices and various names for chips, it will be 
troublesome to select a device directly. At this time, Search box can help. By inputting several key 
characters, the unrelated devices will be filtered a lot, and easily get the selected device. For example, 
if we want to search 25 series FLASH, input 25 in the search box, and then all the devices whose 
manufacturer name or device name include 25 will come out.  
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Note: If the device name is shown in red, it means the device needs authorization. 

4.1.3.2 Device information  

 Device Key Information 

 Manufacturer requirement 

 Agreement for special devices. About operations, some devices have some special 

requirements (or agreements), for example, data buffer arrangement, explanation for 

special operations of devices, etc, besides basic ones. All the information can be found in 

the Device Guidance Manual.  

 Pin Connection. Connect programmer pins and the signals to be written correctly according 

to the pin connection guidance. If multiple channels to be programmed, please connect 

every chip with relative channel in order.  

 

The device information will be shown in a window as following.  
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Method to insert chip 

 DIP package: Put the chip loophole at the top, and the chip bottom is aligned with the socket 
bottom. The following is an example shown by a 28-pin chip.  
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 Non-DIP package such as PLCC, QFP, SOIC, etc.: Right adapters must be used, and insert chips 
according to the procedures shown in Adapter Information dialogue. When inserting chips, Pin 1 must 
be recognized and put it right. Generally speaking, adapter information has a solid square frame or point, 
which is the position Pin 1 should be after insertion.  

 Connected directly: Convert the adapter into 144 Pins, and connect it to a programmer directly.   
 Transfer: Convert the adapter into 48 pins, and insert it into the programmer socket.  

Note:  

1. Generally speaking, the chip pins are face down when inserted. But as to PLCC20 chips, the chip pins 

should be face-up when inserted, called as “Dead Bug”. 

2. SUPERPRO/7100 supports 144 pins 

4.1.3.3 Buffer 

 Manage data in buffer  

 

There are two major types of buffer, Fuse Buffer and Data Buffer (HEX/ASCII buffer). If the data buffer is 

Fuse Buffer, enter the Fuse Buffer window; otherwise enter Data Buffer(HEX/ASCII buffer) window. The 

following commands will be used to in the buffer operation: 

<page Up>                 Move forward 

<page Down>               Move backward  

 

In following section, the operation of these two types of buffer is described and a typical buffer 

operation window is shown below.  
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1. HEX/ASCII Data Buffer  

Every address unit in buffer has 8 digits (one byte). The key TAB is used to switch between HEX and ASCII. 

If needing to input the start address and end address, the end address must be larger or equal to the 

start address.  

 

• Locate. Enter the address of the data you wish to display in the Locate box and select OK to 

quickly move the cursor to the desired location.  
 

• Fill. Enter the Fill box, including three boxes of start address, end address, fill data and two 

buttons of OK and Cancel. Input the data to fill, and specify the start address and end address. For 

Fuse buffer, the data must be 0 or 1; and for Data Buffer (HEX/ASCII buffer) , the data must be Hex, 

such as AA,55, E4. 
 

• Copy. Enter the Copy Buffer dialog box which includes three boxes of 

start address, end address, new address and two buttons of OK and Cancel. 

The data between the start address and end address will be copied into the 

buffer starting with the new address. 

 • Radix. Within the address range, exchange the high bytes and lower 

bytes according to the word width specified by users.  
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Suppose buffer address 0—10 (Hex) is: 

12 34 56 78 90 AA BB CC – DD EE FF 11 22 33 44 55  

The word width can be chosen as: 

16Bits(2 bytes)，the data after exchanged is:  

34 12 78 56 AA 90 CC BB – EE DD 11 FF 33 22 55 44 

32Bits(4 bytes), the data after exchanged is: 

78 56 34 12 BB CC 90 AA – 11 FF EE DD 55 44 33 22 

64Bits(8 bytes), the data after exchanged is: 

CC CC AA 90 78 56 34 12 – 55 44 33 22 11 FF EE DD  

• Radix. Radix the display method for memory address: Hex and Dec.  

• Search. Search for the specified character string or Hex number.  

• Next Search. Search for the specified character string after the operation of Search.  

 

2. Fuse Buffer  

When you select Edit from the Buffer menu with the appropriate file type, the system opens the Fuse 

Buffer Edit window, illustrated below.  
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The data for editing is either 0 or 1. Refer to the data manual of the device and the JEDEC to determine 

which of the following explanations for the data apply.  

• 1 represents an intact fuse and 0 represents a blown fuse, or  

• 1 represents a blown fuse and 0 represents an intact fuse  

4.1.3.4 Device Configuration Word  

Some single-chip microcomputers allow special working modes, such as the storage area mapping, the 

watchdog time, the clock, or the encryption. Set these special modes through the Device Configuration 

Word option. The user files contain the configuration words of some devices. When you load these files, 

the system automatically loads the configuration words into the configuration word buffer. However, 

you must select the configuration words for some devices manually. The following sample illustration 

shows the configuration word for DALLAS DS89C420. It contains the watchdog and three protection 

modes.  

 

Some single-chip microcomputers include many items for the configuration word. The items may appear 

on separate tabs or pages. Make sure to set all the items on all pages before programming a chip. The 

input of the configuration word can be divided into several ways: the 8-bit (byte) edit box input, the 16-

bit (word) edit box input, The single choice input (select and deselect, choose one out of two) , and the 

multiple choice input (choose one out of many) .  

 

The configuration words for chip programming are classified into two categories:  

• If the configuration word contains some protected items, then you cannot verify the items after 

preparing the program. When preparing the program, the programmer automatically shields the 
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protected items and writes the other items. Select Security or Protection to write the protected 

items. NOTE: If you select None as the Protection option, the system does NOT carry out an 

operation when performing Security or Protection.  

• In some devices, the configuration words cannot be separated, so the system does not write 

the configuration word when preparing the program. To write the configuration word in these cases, 

select the corresponding item, such as Write_Option.  

 

Device configuration word varies with devices. Users should set configuration word wells by their target 

system requirements and the Device Data Manual, otherwise the programmer cannot work even if it 

can verify properly. Some FLASH devices also use the configuration word for the protect operation and 

to execute and display the segment protection. Please refer to "Device Operation Function Window". 

 

 
 

Some devices can set erase segment. When erasing, just erase the specified segment set by the user. 
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4.1.3.5 Operation Option 

The operation option includes:  

 

 Insertion Test 

When the chip has 48 pins or less than 48 pins (if more than 48 pins, a special adapter will change the chip 

into a new chip with 48 pins or less than 48 pins), the programmer will execute insertion test automatically 

before programming chips. Once something wrong with the insertion test, the user can abort programming 

or retry the insertion test. Or the user can ignore the insertion test error and program chips directly.    

 Verify Mode 

After programming a chip, to verify the written data right or not is necessary. According to a manufacturer’s 

programming guidance, the verify voltage on the VCC pin has the following changes:   

VCC(+/- 5%) or VCC(+/- 10%) is adopted for the verification. If VCC = 5.00V,  

select one of the following options:  

• VCC = 5.00V and verify the data once  

• VCC = 4.75V and VCC = 5.25V, and verify the data twice (+/- 5%)  

• VCC=4.50V and VCC=5.50V, and verify the data twice (+/- 10%)  

 Remove Interval/Insert Interval 

The waiting period to remove/insert chips in production mode.  
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 Buffer 

Users can choose to program only a part of the chip, such as with most E/EPROM (FLASH) devices.  

 

 

 

 

Note: 

1. Double check Buffer to set the operation address 

2. When cancelling any buffer, it means the cancelled buffer will not be written this time. 

• Dynamic Buffer  

Sometimes one needs to write some special information at a local part on the chip, for example, product 

series number, MAC address, etc. This software supplies two methods, Auto Increment and User 

Defined. The former will automatically generate a new accumulative number, and the latter will get a 

serial number from a user defined software.  
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To execute, the current serial number needs to be written at the specified continuous 8-bytes area in 

buffer in the chip before any programming. Auto Increment needs to do the following steps before 

working:  

 Select Data area 

 Start address 

 End address 

 Step, that is, Inc. Step 

 Automatic serial number increment method: Starting from the start address, increased by a 

byte(the maximum Dec number is 255), what value to reach will trigger the tens digit or 

hundreds digit to increase.  

 Increment direction 

 Initial value 

 

Here the "address" means the buffer address, and the start address is smaller than the end address.  

    

Binary: Start value 0, overflow value 255 

ASCII Decimal: Start 30(Hex, character '0'), overflow 39+1(Hex, larger than character '9') 

ASCII Hex: Start 30(Hex, character '0'), overflow 46+1(Hex, larger than character 'F'), and '9' plus 1 turns 

'A'. 

 

For example: One wants to program 64 chips. Their ID is from 0001 to 0064, and their location is at 

EPROM end address of 89C51. If choosing 4 bytes of Decimal format, then the procedure is as following: 

Choose Auto Increment item, set the start address as FFC(Hex), end address as FFF(Hex). Data will 

change since end address, and the start address must be larger than the end address.  
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Set the increment value as 1, and increase from higher address to lower address.  

Set the format as ASCII Decimal. Enter the buffer window, make a change in ASCII area(Hex): 

FFC: 30   FFD: 30   FFE: 30   FFF: 31 

During the programming, the operation panel will display: 

Current serial number: 0001 

In the next programming, the last four buffer bytes will be: 

FFC: 30   FFD: 30   FFE: 30   FFF: 31 

If the programming operation succeeds, the serial number will increase by 1, and display: 

Current serial number: 0002 

The last four buffer bytes will be: 

FFC: 30   FFD: 30   FFE: 30   FFF: 32 

 
• User Designed Auto Increment  

 This function needs authorization. Users can change data at their will at the beginning or every time 

their programming succeeds.   

 

 When programming, the software will record programming status parameters automatically or by 
users' setting. By default, just 'Program' function is selected, and can change default choices in this 
window. 

 In Auto operation, only the chosen items included in the Auto can be executed.  

Note:  

1. The operation option will vary with devices. For example, most single-chip machines do not permit 

users to change start/end address. Stand-alone mode does not support Auto Increment. 

2. When GANG2, GANG4 or GANG16 are chosen, the General Property panel will display Adapter 

Setting, all chosen by default. When any adapters are not chosen, programmer will not write them, the 

interface LEDs turn grey and the programmer indicators will turn off.  
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3. If the chosen devices belong to ISP type, the ISP property panel will show up.  

 

Users can set the working voltage, programming voltage, clock frequency and speed.  

4.1.3.6 Auto Programming 

In the Operation panel, all devices have a basic operation: Auto. Its function is to put all other 
operations in the Operation window together in order to be executed automatically as a batch. For 
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example, choose device EON EN25F80@SOP8, open Auto dialogue. On the left of the dialogue, the 
Function List panel displays all the functions, and on the right the Auto panel lists all the operations to 
be executed and the order.  

 

Shown in the window above, Auto will execute Erase, BlankCheck, Program, Verify.  

 Add: Add the functions highlighted in the left Function List into the right Auto list.  

 Delete: Delete the functions highlighted in the right Auto window. 

 Upward: Move up a step the function highlighted in the right Auto window. 

 Downward: Move down a step the function highlighted in the right Auto window. 

 Reset: Set Auto as Default. 

 

Double click the function in the left Function List, equals to add the function; double click the function in 

the right Auto panel, equals to delete the function. 

4.1.3.7 Verify Sum(Checksum) 

    For more details, please refer to Chapter 5, 5.3.   

4.1.3.8 Data Comparison 

Data Comparison: This function applies to most memories and single-chip machines. Taking a byte as 
unit, compare the data in buffer with the data in the chip. When data are different, record the address , 
buffer data and chip data in a log file and save it in the BIN folder. Users can find the complete file name 
with reference information shown in the Operation panel. 

 Sample for data comparison 

 There are seven differences totally, and the comparison result is saved at C:\SPIS03\BIN\27256.CMP 
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File format is as following: 

Address                BufData                  ChipData 

000000000               FF                       52                    

000000001               FF                       61                    

000000002               FF                       72                    

000000003               FF                       21                    

000000004               FF                       1A                    

000000005               FF                       07                    

000000006               FF                       00                    

 

4.1.4 Programmer 

4.1.4.1 Module management 

Set the maximum number a programmer can connect, and valid after restart.  

 

4.1.4.2 Production mode 

Production mode is used to program a large amount of devices. ISP programmer will automatically 

detect chip insertion or removal by the system expansion testing function(seen in 3.4), and finish 

programming. In this mode, if not supporting reminder comes out, it means the chosen device cannot 

be written in production mode. 

Recommendation: Choose devices, edit the Auto commands and test, choose production mode after 

testing, run Auto, operate by the reminder shown in the Operation panel. 

 "Please insert new chips...." reminds users to insert chips into the socket or the inserted chips are 
not placed properly. When the chips are placed properly, the software will run Auto immediately. 

 "Please remove the programmed chips..." reminds users that the programming has finished, 
please take away the chips from the socket. At the meantime, please read the information in the 
Operation panel to check if the programming succeeds or fails. If needs to stop Production mode, please 
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click Production mode once again in the File menu, or   in the toolbar. 

4.1.4.3 System Self-check 

Users can check if the system hardware runs properly or not by running "Programmer"-->System Self-
Check.  

Checking items include memory, pin driving, clock, etc. Note: When running System Self-Check, no chips 
should be on the adapter.  

The testing report will appear like the following: 

Self-check Report Sample for Xeltek Programmer 

Programmer Model: SUPERPRO 7100                   Programmer ID:                                              

Operator:                                           Time:   2013-06-20   14:10:44   

Check Item Result 

Chip Short Circuit Check Pass 

Ground Connection Check Pass 

Pin Driving Testing  Pass 

Pin Logic Testing Pass 

System Clock Testing Pass 

4.1.4.4 Voltage Testing 

One measures the programmer voltage by a multi-meter according to the following figure . PIN1 is V1, 

PIN24 is GND, PIN25 is V2 and PIN48 is V3. 
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Once clicking Enter key, the system will measure the current voltage (the highlighted item in the list), at 

the same time the highlighted item will move to the next. 

4.1.4.5 System Update 

Update the programmer built-in software, and rebooting after the updating. 
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4.1.4.6 Rebooting 

Do not need cut off the programmer power, just software rebooting. 

4.1.5 Option 

4.1.5.1 Global Mode 

When the software is set as multiple module status, the global mode is selectable. In the global mode, 
all the operations such as select chips, load file, edit buffer, device configuration word, and edit Auto are 
suitable to all modules. At this time, if wanting to program one single chip, choose the corresponding 
programmer panel, click the Auto button, or right click the button to run step by step.   

4.1.5.2 Protection Mode 

Designed for safety management. In this mode, only a limited operations can be run to avoid man-made 

errors to damage chips or write wrong data into the chips.  

 

Managers can set password when entering. If password has been set, need password when quitting.  
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Shown as the above figure, looking at the buffer, the buttons on the left window and programmer panel 

are active.  

4.1.5.3 Log File 

Save the operation information into a file. During the executing, some data are saved in the buffer, so 

save them into the file when quitting.  

 

1．Do not save. Do not save the current log information.  

2．Create a new file. Save the current log information. If a log file exists, cover it.  

3．Add into the current log file. Save the current log information. If a log file exists, add the new 

information at the end of the current log file.  



SUPERPRO® 7100 User's Guide                                 - 51 -      

4．The whole directory of log file can be modified.  

4.1.6 Tool  

4.1.6.1 Password Generator 

 

Project Password:  The password set when building the project file.  

Random Code: If project configuration contains dynamic code, one random code will be reminded when 
loading the project file.  

Dynamic Code: The dynamic code can be built by the project password and random code.  

4.1.6.2 Help 

Help file contains the Programmer Manual.  

4.1.6.3 Contact Us 

Xeltek telephone number and address.  
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4.1.6.4 Order Generation 

 

 

When users order the device authorization, make the order by this tool. What the user needs to fill in 

are user name and programmer serial number. Click Add button to add programmer serial number. 

After click OK, an order will be built. Send this file to the sales department.  

Note: Due to the long serial number, be careful to fill in it. There are two spaces among the serial 

number.  

 

4.2 Tool Bar  

The tool bar provides a quick way to execute common functions. The toolbar from the main SUPERPRO 

screen is illustrated below. Each tool is labeled with a number and described below.  
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1. Load file  

2. Save file  

3. Load project  

4. Save project  

5. Edit buffer  

6. Calculating the Checksum  

7. Select device  

8. Device information  

9. Device configuration word  

10. Edit Auto  

11. Option  

12. Logic test  

13. Production mode  

14. Factory mode  

15. Global settings  

16. Help  

4.3 Device Operation Window  

All the operation options one device can run when programming are displayed in this window. After 
finishing programming preparation, one can run relative operation by requirements. The following is the 
operation interface for E0N EN25F80@S0P8. 
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Different devices have different operation options. The following description is for most common 

operation: 

4.3.1 Auto 

Its function is to organize the other functions in order and run them. Please refer to Menu Auto. 

4.3.2 Read ID  

Some chips have IDs, and users can check whether the IDs are right or not by running this function. If 
not right, there two reasons:  

1. The chips on the adapter are different from the chosen chips by customers; 
2. Poor connection between the chip and the adapter or no chips inserted in the adapter.  

4.3.3 Programming 

Write the buffer data into chips. There are two methods to verify programming. The first one is to verify 
while programming. Once something wrong happens, the programming will stop. So finishing the 
programming process can ensure the programming right. The second one will not verify while 
programming. Even if something wrong happens during programming, the system will not stop. And 
after the last address is written, it will show programming success. In a word, successful programming 
just means the process finishes, and the user should verify the result separately. 

4.3.4 Read 

Read chips and save into buffer.  

Note: 

1. As to encrypted chips, the system cannot read the encrypted part; 

2. As to the chips with configuration word, the configuration word will be read out and saved 

into the buffer; 

3. As to PLD devices, their measuring vectors are not in the chips, so not readable.    

4.3.5 Verify 

Verify whether the chip data are different from the buffer data. Once something wrong happens during 
verifying, the process will stop and show error message. The error message for most memories and 
single-chip machines includes address and data; however, the error message for PLD devices depends 
on programming material. Only the chips passing verification are successfully written .Some chips do not 
supply unit to unit verification but only accumulative verification similar to VerifyCRC. A very few chips 
do not supply verification functions even the accumulative verification, but can be verified automatically 
during programming.   

4.3.6 Blank_Check 

To check if the chip is empty. The chip empty status is determined by data manual. If emptying data 
buffer when changing devices, then after choosing devices, the HEX/ASCII buffer will be filled with FF or 
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00(Hex) and fuse buffer will be filled with 1 or 0. Chips may show empty after encrypted. EEPROM(the 
recoverable chips) do not need empty check. 

 

How to make one chip empty? 

1) Electrically erase chips by executing Erase  

2) Erase chips by UV light for 3 - 30 minutes 

3) Program chips at one time (OTP). Never empty after writing 

4.3.7 Erase 

Erase chips and make them empty. Only the electronically erasable chips apply. It is not necessary for 
EEPROM(recoverable chips). If EEPROM needs to be empty, write empty data into the chips. Some 
electronically erasable chips can set whole or a part as OTP chips by setting configuration word. Please 
read data manual carefully. 

4.3.8 Protect 

1) Encryption makes chips unreadable. Whether encryption status can be read affects how to edit chip 
functions. If the encryption status is unreadable, encryption function will be written directly into the 
Operation panel. Once executing encryption function, chips will be encrypted. If encryption status is 
readable, the configuration word will list None and all encryption choices for users to choose. Executing 
the encryption function, the chips will be operated by the configuration word. Especially, if None is 
chosen, executing the encryption function means empty operation.  

Reminder: Some chips with windows are not reusable once completely encrypted even if erased by UV 
light.  

2) As to FLASH chips, this operation will protect the data in chips. The chips cannot be programmed 
before removing the protection. Note:  Erasing can remove protection.  

This function should combine with device configuration word (Dev.Config) to determine the sector to 
protect. There are two ways to choose sectors to protect. The first one is to permit users to give the 
addresses for eight sector groups. Each sector group can contain many sectors, and all the given 
addresses will be protected after executing this function. The other one is to set the chip sectors as a 
prescribed plan.   
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4.3.9 Security:  

Same with Protect, but the chip cannot be read. 

4.3.10 Erase_All:  

Same with Erase. 

4.3.11 Protect_All:  

Same with Protect. 

4.3.12 Lock_Bit: One Encryption Method 

For more information, please refer to data manual. For example to operate Atmel At89c51, there are 
three operations: Lock_Bit1, Lock_Bit12 and Lock_Bit123. For more details, please refer to data manual. 

4.3.13 Device Data Manual 

4.3.14 Device Special Information (Dev.Information) 

Ask for technical support to Xeltek. 

Note: Such operations as Protect, Security, Erase and Lock_Bit depend on specific device desitions. 
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4.4 Operation Panel  

The interface between programmer software and users displays device information, 

buffer, data and log information for the current module.  

 

Note ： Normally, chip Checksum will be the sum of total or partial buffer 

verification sums, and the algorithm is determined by users. For more details, please 

refer to Checksum.  

4.5 Programmer Panel 

   

1. Module number is consistent with LCD number. In multiple programmer mode, this number can be 

used to identify the relationship between panel and programmer. If online, it shows the corresponding 

programmer ID.  

2. Execute Auto or Cancel 

3. Current chosen devices 

4. Indicate the current status and adapter mode. The green light indicates successful operation or 

ready to program; the red light means operation failure, the yellow light shows the programmer is still 

working, and the grey light represents no current connection or some units in adapters are forbidden.  
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The indicator layout is consistent with adapter units. For example, if using GANG4 and 2*2  adapter 

layout,  the indicator area should be as following: 

 

5. Record the numbers of success or failure. The rule by default is:1) Running Program, if succeeding, 

the number of success increase 1, otherwise the number of failure will increase 1. 2) Running Auto and 

operation Program in Auto, if succeeding, the number of success increase 1, otherwise the number of 

failure will increase 1. 

Button Reset will make the number of success and the number of failure to 0. 

   6. Set Countdown 

   Set as following: 

 

 

When the countdown value is larger than 0, trigger counting function. Reduce 1 when programming 

succeeds once until 0.The countdown function is to control the programming times in production 

mode. For example, one can input 1000, and then when 1000 programming finish, it will stop. When 

in stand-alone production mode, input the programming number and save as project file. Now the 

project file contains production control information. If encrypting the SD cards, the production control 

will be more efficient.  

7. Simple reminder for current status and programming progress  

8. If a serial number is set for the module, the serial number will be displayed. 
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4.6 General Statistics Panel 

When in multiple programmers mode, the general statistics panel will come out, displaying the 

failure/success information for all modules.  

 

 

 

 

 

 

 

 

Chapter 5 Frequently Asked Questions (FAQ)  

You can monitor the programmer operations through the Operation Information Window and message 

window. This chapter helps define common problems related to programmer actions and errors.  

5.1 Data File 

 How to use the File Type dialog box will be discussed here in details. 

5.1.1 Intel Hex, Motorola and Tektronix 

The data for programming is usually stored in the data file. Commonly used formats are Intel Hex, 

Motorola and Tektronix. The files of these formats keep data in text mode, which include data and 

address information. Because the offset address is not always zero, you may incur errors when loading 
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the file directly. For example, the location of data in buffer (as viewed in the Edit Buffer window) may 

be incorrect or you may receive an error message when loading the file, such as Invalid file type, or all 

file data overflow. Select one of the following options to solve this problem.  

• Confirm the file type and ensure the buffer can load all the files.  

• Find the minimum offset address of the file. After selecting the file, software will scan the file 

automatically and write the minimum offset Address. 

5.1.2 Separate File Data for Programming  

By using the File Load Mode selection in the File Type dialog box, you can select the data of a file and 

write it into several chips of the same type. This allows you to load the file several times according to 

your needs. There are three methods for separating the file data:  
 

• Based on byte (8bit), divide the file into two parts by the odd and even address. Program the 

two parts into two chips respectively. When loading the file, select Even as the File Mode to write 

the data in the addresses 0,2,4,6, etc. to one chip. Select Odd as the File mode to write the data at 

the address 1,3,5,7, etc. to the other chip.  
 

• Based on the byte (8-bit), divide the file into four parts by address of the first byte, the second 

byte, the third byte and the fourth byte out of every four bytes. Program the four parts into four 

chips respectively. When loading the file, select the 1st byte of 4 as the File Mode to write the data 

in the addresses 0, 4, 8, 12 (or C if HEX), etc. to one chip. Then select 2nd byte of 4, 3rd byte of 4, 

and finally 4th byte of 4 to write the remaining data to the other three chips.  

• Based on the word (16-bit), divide the file into two parts by address of the first two bytes and 

the last two bytes out of every four bytes. Program the two parts to two chips respectively.  

5.1.3 Program Two or More Files to One Chip  

Users can load several files into a buffer and write them to a chip. The following explanation gives an 

example of programming three files (Sample1, Sample2, and Sample3) to one chip. Write Sample 1 

data from address 200(Hex) into address 0 in the chip, Sample 2 data from address 0(Hex) into address 

3000(Hex) in the chip, and Sample 3 data from address 4000(Hex) into address 4000(Hex) in the chip.  

1. Select Edit from the Buffer menu. Make sure that the Buffer clear on data load option is not 

checked.  

2. Select Load from the File menu to load the Sample1 file.  

o In the Buffer Start Address field, enter 0.  

o In the File Start Address field, enter 200.  

3. Select Load from the File menu to load the Sample2 file.  

o In the Buffer Start Address field, enter 3000.  

o In the File Start  

4. Select Load from the File menu to load the Sample3 file.  

o In the Buffer Start address field, enter 4000.  

o In the File Start Address field, enter 4000.  
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5. Continue with programming. 

 

If there are no changes in the file requirements or content of the three files (Sample1, Sample2, and 

Sample3), you can save the data in buffer to a new file, such as Sample4, for easily loading and 

programming next time.  

5.1.4 POF Format Files  

When programming ALTERA PLD devices, the system saves the data in POF format files. When loading a 

POF Format file, the system displays a File Type dialog box.  

Select one of the following:  

1. POF file: The system transforms the data into the Fuse data and checks the  

data when you load it to the buffer. You may receive one of the following  

errors:  

 Unmatched file to this chip: This POF file does not match this chip. The POF file is related to the 

device when it is compiled. The error indicates that this POF file is not for this device. Replace 

the chip with a matched one.  

 The POF file has errors.  

 Load POF file Dll error (not found): An auxiliary file has errors. Contact technical support for 

assistance.  

2. Files of other formats are mainly the JED files. The system saves data in the buffer in a JED file 

after reading the chip. You can use this format the next time you load the file.  

5.2 Adapter Selection  

How to get adapter?  

Please refer to Device Information (Dev.Info). Take TSOP48 as a sample: The adapter is on a programmer 

driven by 144pin, and its order number is EX1004. 
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Note: Please order Xeltek original adapters to use here; otherwise some online errors may happen. 

5.3 Verify Sum(CHECKSUM) 

When the data type in buffer is HEX/ASCII, by default the verification and calculation will accumulate all 

the data from address 0 to the maximum with byte as unit. In order to meet customers’ special 

requirements, accumulate the data from partial or whole address by a specified method. 
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1） Select the buffer to calculate 
2） Set calculation range, double click the start address and end address. 
3） Select calculation type: byte accumulation, word accumulation, （large end alignment or 

small end alignment）, PLD calculation method 

4） Take the original code, reverse code, or completion code of the calculation result as the 
final result 

5） Display the CHECKSUM of this buffer 
6） Set the buffer to calculate CHECKSUM 
7） Accumulate all buffer CHECKSUM, and take the original code, reverse code, or completion 

code of the accumulation sum as the final result 
8） Chip CHECKSUM 
9） Whether to hide the CHECKSUM on the main interface 

5.4 Programmer Panel Style 

SPIS03 supplies two styles. Normal style programmer panel contains programmer ID, current device, 
statistics information, etc, and the precise style only displays serial number, status, and operation 
buttons. The following shows the interface at precise style for four programmers connected in parallel.  
 

 
 

Appendix  

6.1 Technical Support  

    Xeltek software needs minimum technical support. A User Manual Guide will be attached with the 

software. If the User Manual does not answer your questions, first contact your sales agent or the 

distributor. If you still need technical assistance you can call XELTEK between Mon‐Fri 7:30AM‐12:00PM 

& 1:00PM ‐ 4:30PM (PST). Make sure you have your product serial number before calling.  
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    XELTEK periodically publishes upgrade software on the XELTEK website. You can download and 

upgrade your software from the website. Non‐users may download the software for evaluation.  

    Before contacting XELTEK, check the following to ensure you get the best service.  

• Read the User Manual.  

• If you receive an error message that is not explained:  

• Make sure you can repeat the circumstances that created the error.  

• Write down the error message.  

• Make sure you have your product serial number.  

• Check your computer configuration, including computer brand, free memory size before 

starting the software, the video adapter brand, and the operating system.  

• Make sure you are at your computer when you call so the engineer can guide  

you through the solution.  

 
 

Contact Information  

 

XeltekInc.  

1296 Kifer Rd. Suite # 605  

Sunnyvale, CA 94086  

United States  

 

General Consultation  

001‐408‐530‐8080  

 

Order/Sales  

001‐408‐530‐8080  

Email: sales@xeltek.com  

 

 

Technical Support  

001‐408‐530‐8080  

Email: techsupport@xeltek.com  

Fax: 001‐408‐530‐0096  

Website: http://www.xeltek.com  

 

 

 

 

 

mailto:sales@xeltek.com
mailto:techsupport@xeltek.com
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6.2 License Agreement  

The copyright of the program and the User’s Guide remain the property of XELTEK.  

 

You may:  

1. Copy the program for back‐up purposes ONLY in support of its use on a single computer.  

2. Transfer the program and license to another party if the other party agrees to accept the terms and conditions of this 

agreement.  

 

You may not:  

1. Use this product on a computer system or network that allows the program to be operated by more than one user at 

the same time.  

2. Modify, copy, or transfer the User's Guide or other documentation or any copy.  

3. Decompile or disassemble any program modules or encrypted devices.  

6.3 Warranty  

XELTEK has a strict quality assurance system. If the software or hardware has any defects, it can be repaired or replaced 

free according to the specific situation within one-year period after the user buys the product.  

 

The warranty is based on proper installation of the software and usage in the specified working environment. XELTEK is 

not responsible for the following cases:  

• The product has been repaired, used, or changed by any organizations or persons who are not authorized by 

XELTEK.  

• The product has been damaged because of misuse or careless use.  

• The product serial number has been changed by the user or some other person.  

• The program errors caused by the physical damage of the disk.  

 

 

6.4 Feature Comparison Table for SUPERPRO Series Programmers 
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Speed 

(P+V) 

Amount of 

Supported 
Devices 

Driving Scale 
Stand-alone 

Function 
Number that  

SD/CF Saves 
Project Files 

Production Mode 

Adapter 

Connection 
Mode 

Commu.  

Interface 
Application 

SUPERPRO /7000 
Ultra High 

Intelligent 

★★★★★★ ★★★★★★ 
144 Pin  Driven 

×1 Module 
Support 

No limit, only 
related to SD card 

size 

Stand-alone mode, 

multiple computer 

connected in 
parallel  

Connected 

directly1 
USB2.0 

Faster 30 percent than SUPERPRO/6000, support most 

devices, suitable for high-end R&D and large scale 

production, especially suitable for large size FLASH memory. 
Stand-alone 

SUPERPRO  

/6004GP Ultra    

High Intelligent 

★★★★★★ ★★★★★★ 
144 Pin Driven 

×1 Module 

Support - 
Various CPUs work 

separately and 

asynchronously. 

Connected 

directly1 
USB2.0 

Faster 30 percent than SUPERPRO/5004GP, support most 

devices, suitable for high-end R&D and large scale 

production, especially suitable for large size FLASH memory.  

SUPERPRO/5000 
Ultra  High 

Intelligent 

★★★★★ ★★★★★☆ 
144 Pin  Driven 

×1 Module 
Support 

No limit, only 
related to SD card 

size 

Stand-alone mode, 
multiple computer 

parallel connection 

Connected 

directly1 
USB2.0 

Ultra high speed, support most devices, suitable for high-end 
R&D and large scale production, especially suitable for large 

size FLASH memory. Stand-alone 

SUPERPRO 

/5004GP Ultra high 

Production Mode 

★★★★★ 
★★★★★☆ 144 Pin  Driven 

×4 Modules 

None - 
Various CPUs work 

separately and 

asynchronously 

Connected 
directly1 

USB2.0 
Ultra high speed, support most devices, suitable for large scale 
production, especially suitable for large size FLASH memory.  

SUPERPRO /5000E 

Ultra High 

Economic Mode 

★★★★★ ★★★★★ 
144 Pin Driven 

×1 Modules 

Support No limit, only 

related to SD card 

size 

Stand-alone mode, 

multiple computer 

parallel connection 

Connected 
directly1 

USB2.0 Except for supporting less devices, same with SP/5004GP. 

SUPERPRO 

/5004EGP Ultra 
High Production 

Economic Mode 

★★★★★ ★★★★★ 
144 Pin  Driven 

×4 Modules 
None - 

Various CPUs work 

separately and 

asynchronously 

Connected 
directly1 

USB2.0 Except for supporting less devices, same with SP/5004GP. 

SUPERPRO /501S ★★★★★ ★★★★☆ 
48 Pin  Driven 

×1 Module 
Support 16 project files 

Stand-alone mode, 

multiple computer 
parallel connection 

Transfer2 
USB2.0 

Mainly support devices with less than 48 pins（the device 

number supported is a little lower than SP3000U）, speed is 

same with the No.8 generation of products such as SP/5000. 

Can be used as stand-alone. 

SUPERPRO /500P ★★★★★ ★★★★ 
48 Pin  Driven 

×1 Module 

None -  Transfer2 
USB2.0 

Mainly support devices with less than 48 pins (support the 

same number devices as SP580U）, speed is same with the 

No.8 generation products such as SP/5000. 

Description 
many times 
higher than 

competitors 

Statistics Date: 

2008.6 

More pins to be 

driven, the more 
extensive  the 

adapter is  used 

generally 

 

 
Asynchronous 

method improves 
efficiency. All types 

have inductive self-

starting method 
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SUPERPRO 7100 Stand-alone Operation Specification 

1. Overview 

Insert SD card into a programmer, turn it on, press any key on the programmer keyboard, and then the 

programmer will run in the stand-alone mode. If message NO SD FOUND comes out, please check if SD card 

inserted properly, and then restart again.  

Basic Features 

 Ultra high programming speed. The period to program and verify a 64Mb NOR FLASH is just 11.3 seconds. 

 One built-in CPU, 6 keys membrane keyboard, 20X4 LCD display, and SD card socket.  

 Up to 96 universal drive circuit, universal adapter, support E/EPROM, FLASH, single-chip machines, PLD, 

SRAM testing with voltage low to 1.5V 

 A production mode programmer has an exclusive automatic testing pin. Once a high voltage is detected, 

AUTO will run automatically.  

 To ensure the reliability of data resource file, one can choose functions such as running CHECKSUM or 

forbidding reading by needs.  

 Project management: Operation is very simple. It can set two protections by both SD card and project file 

encryption.  

2. Refresh Algorithm Library 

Stand-alone operation must equip SD cards. All record related to stand-alone operation is saved in the format of 

PROJECT. Project contains device type, data file, device configuration word setting, AUTO batch command 

series, etc. In a word, one can start working once choosing Project from the menu after opening his/her 

computer. Building a Project file must be done in online mode and saved into SD cards (or download to SD 

card by card-reader).  The reason why to do so is to simplify stand-alone operation to avoid production loss by 

wrong operation. The project number for a SD card to save is just limited by SD card size. When building or 

downloading a project file library, if the library is bigger than the size a SD card can take, the software will 

give reminder message. At this time, reduce the number of project files or exchange a bigger SD card.  For 

more information about how to build or download the project file library, please refer to Library of Standalone 

Mode in Online chapters.  

3. Menu 

Keyboard Rule 

ENTER Choose and enter sub-menu 

EXIT  Quit to upper menu 

，  Up/ down roll to choose function. Change the address when BUFFER displays 

，  Choose address when BUFFER displays 

1．RUN 
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Finish all operations in this menu. There are some different functions for various devices, but the common 

functions are as following:  

AUTO              Execute User Defined AUTO（Set when building the Project） 

READID            Check chip ID 

PROGRAM         Write the BUFFER data into a chip 

READ         Download chip data into BUFFER (SD card).  

           （Note: Only valid when READ OPTION is activated and will change the project file data.) 

BLANK CHECK    Check whether the chip is empty 

VERIFY  Compare whether the written data in chips same with the BUFFER data 

ERASE  Erase the chip 

SECURE  Encrypt the encryptable chips, LOCK/MEMORY PROTECT have the same function  

                      with it 

LCD Row 4 will display the running result. “－”represents the inactivated units (channels), "O" means 

succeeding units (channels), and "X”shows failing units (channels). For example, OOOX represents Channel 

1，2，3 succeeded, and Channel 4 failed; OOO－ means Channel 1，2，3 succeeded, and Channel 4 was 

inactivated. (That is, Channel 4 was not chosen.)  

2．SELECT PROJECT 

Select the project saved in the SD card. Using  or   to roll the corresponding project after entering. Once 

entering again, automatically download the algorithm and data of the selected project. Save the selection result 

automatically after choosing type every time, and run directly without selecting again next time to restart your 

computer. 

3．SETTING 

1 ）READ OPTION 

Activate or inactivate this function by  or  between Yes or No after entering. By default, it is No. This 

function will change the initial project file, must be careful to use. However, it can’t change the saved initial 

data file CHECKSUM, so the CHECKSUM error message will come out.  

2 ）AUTO CHECKSUM 

Activate or inactivate this function by  or  between Yes or No after entering. Once activated, it will 

automatically checksum before executing RUN. By default, it is No.  

3）PIN CHECK DISABLE 

Activate or inactivate this function by  or  between Yes or No after entering. By default, it is No. It will 

check pin automatically before operating chips. Once activated, it will not run pin check.   

4）BUZZER 

Activate or inactivate this function by  or  between Yes or No after entering.  

4．BUFFER 

1）CHECK SUM 
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Calculate Buffer CHECKSUM, and compare with the CHECKSUM saved in the current project. If different, 

display the two CHECKSUM at the same time. Both physical and man-made reasons can make CF card data 

destroyed, and make the written chips disabled. So recommend running CHECKSUM at last once before any 

operation after restarting the computer, or run it automatically. Please refer to the following AUTO 

CHECKSUM.  

2） Display BUFFER  

Display BUFFER. The start address and data will display once pressing ENTER. Press  or  to move cursor 

to the address where to change. Move    or    to change the cursor address. The address will increase 1 

successively once pressing ENTER. 

3） Display BUFFER 1 

Display BUFFER1. Same operation with Display BUFFER. 

5 . PRODUCTION MODE  

The programmer will monitor the socket status after entering. Once a chip is inserted and contacts stably, the 

programmer will run the user defined AUTO automatically. 

6. STATISTIC 

Display the programming statistics data, including successful times and failure times.  
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OS Flowchart for Standalone SUPERPRO 7100  

 

 

 

 


